
 

 

74       | Vol. 5 No. 1 | Feb. 2017 

 

 Techno Preneurship Jurnal Ilmiah Politeknik Piksi Input Serang 

 

PERANCANGAN SISTEM INFORMASI INVENTORY BAHAN BAKU 
GUDANG PADA PT. LUNG CHEONG  

BROTHERS INDUSTRIAL 
 

IKBAL NIDAUDDIN 
POLITEKNIK PIKSI INPUT SERANG 

JL. TRIP JAMAKSARI NO 6 A CICERI SERANG 

 
 
Abstrak 

 
At globalization era like this time, requirement to information system progressively 
mount, especially in privat enterprise. Information system application designed pursuant 
to requirement of work. One of them is design system application of inventory warehouse 
raw material in PT. Lung Cheong Brothers Industrial. In this final duty explain about 
system exist in PT. Lung Cheong Brothers Industrial. PT. Lung Cheong Brothers 
Industrial is a company which active in children toy industry. Research method used by 
writer is analyst system and of design structure by using method emit a stream of  Data 
or data of Flow Diagram (DFD) with four entity, that is Warehouse, Supplier, 
Departement, and Manager. Software the used is Microsoft Windows XP and of 
Microsoft Visual  Basic 6.0. Hardware the used is Intel Pentium III 2.4 GHZ, Random 
Access Memory (RAM) 256 MB, Harddisk 40 GB, and Printer.  By using computerized 
information system, can quicken process of[is forwarding of information to division 
requiring. So that process raw material inventory faster. As for finding of system old 
ones is data-processing system which still inexistence and manual of back-up data.  
Applied of this system, hence data processing earn efficient and effective. And for the 
usage of system, expected by consumer can know existing functions, comprehending 
input, process, and output to facilitate data processing of raw material inventory so that 
can yield accurate report and can be justified.  
 
Key Word  : Inventory Raw Material Warehouse 

 
A. PENDAHULUAN 
1. Latar Belakang 

Kemajuan zaman selalui ditandai dengan adanya 
perubahan teknologi yang semakin canggih dan hebat dalam 
penggunaannya. Revolusi teknologi ini terutama teknologi 
informasi telah memunculkan suatu budaya global, tidak 
terhambat teritori dan kekuasaan wilayah negara yang satu 
dengan yang lain. Arus globalisasi menerpa semua negara, dari 
waktu ke waktu berhembus dengan tingkat intensitas yang 
semakin cepat. Maka dari itu kebutuhan terhadap informasi 
secara cepat, tepat, dan akurat sangat diperlukan sebagai bahan 
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untuk pengambilan keputusan. Di dalam pengambilan 
keputusan, komputer merupakan salah satu sarana untuk dapat 
membantu sistem pengolahan data, sehingga sistem yang 
menggunakan sistem yang terkomputerisasi akan mempunyai 
nilai lebih daripada sistem yang diolah secara manual, dengan 
kata lain sistem yang menggunakan komputer tentu lebih efektif 
dan efisien. 

PT. Lung Cheong Brothers Industrial yang bertempat di 
Serang Banten Indonesia adalah sebuah perusahan industri yang 
bergerak di bidang usaha spesialisasi produksi dan 
pengembangan inovasi produk-produk plastik, dimana sebagian 
besar ditujukan untuk pasar export.  Perusahaan ini berkembang 
dengan sangat pesat, dan seiring dengan laju perkembangannya, 
perusahaan ini telah melakukan pembenahan-pembenahan, baik 
bersifat fisik maupun manajemennya. Namun berdasarkan 
penelitian yang penulis lakukan, di dalam penanganan sistem 
pengolahan data inventory bahan baku gudang masih belum 
mempunyai database  (pangkalan data) yang terintegrasi, sehingga 
tidak dapat mengontrol data dengan baik. Karena unsur 
persediaan (inventory) bahan baku sangat penting di dalam 
perusahaan, maka diperlukan satu penerapan atau cara 
pengolahan yang efektif. Pengolahan persediaan bahan baku yang 
baik mampu memberikan informasi bagi manajemen sehingga 
aktifitas bagian produksi akan berjalan dengan lancar. 
Sehubungan dengan hal itu maka manajemen harus dapat 
merencanakan dan mengendalikan suatu jumlah persediaan 
bahan baku yang cukup untuk memenuhi kebutuhan bagian 
produksi sehingga persediaan yang dibutuhkan bagian produksi 
tidak berlebihan ataupun kekurangan. Dalam membantu 
menangani pengolahan data bahan baku, diperlukan suatu sistem 
informasi dengan menggunakan komputer sebagai sarana untuk 
pengolahan data persediaan bahan baku dalam upaya 
pengendalian persediaan (inventory) bahan baku gudang.  
  

2. Masalah Penelitian 
Masalah dalam penelitian ini adalah sebagai berikut : 

a. Mengidentifikasi apakah sistem informasi pengolahan data 
inventory gudang dapat memberikan hasil yang maksimal dan 
memuaskan ? 

1 
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b. Apakah memerlukan usulan dalam meningkatkan 
pengolahan dan pendataan yang berhubungan dengan sistem 
informasi pengolahan data hasil inventory gudang ? 

c. Dengan perbaikan hasil terhadap sistem informasi yang telah 
ada, apakah dapat membantu dan mempercepat dalam 
pengolahan data inventory gudang ? 

 
B. LANDASAN TEORI 
1. Konsep Dasar Sistem 

Dalam sebuah elemen organisasi sistem adalah sangat 
penting, begitu pula dengan informasi dalam upaya 
meningkatkan sebuah instansi atau perusahaan dan untuk 
melangsungkan kehidupan organisasinya, untuk itu penulis akan 
menjelaskan apa itu definisi dari sistem itu sendiri. 
1.1. Definisi Sistem 

Dalam pengertian luas sistem dapat diartikan 
dengan Sekumpulan elemen yang saling berinteraksi 
untuk mencapai tujuan tertentu. Tetapi perlu kita 
bandingkan dengan pendefinisian Sistem tersebut dengan 
definisi Sistem oleh para ahli. 

 “Sistem adalah suatu jaringan kerja dari prosedur-
prosedur yang saling berhubungan, berkumpul bersama-
sama untuk melakukan suatu kegiatan atau 
menyelesaikan suatu sasaran yang tertentu”. [Djogiyanto, 
2005 : 1]. 

Menurut Gordon B Davis, di dalam bukunya yang 
berjudul Kerangka Dasar Sistem Informasi Manajemen 
definisi sistem dibedakan menjadi dua yaitu : 
1. Sistem Abstrak, yaitu susunan yang teratur dari 

gagasan atau konsepsi yang saling ketergantungan 
satu sama lainnya. 

2. Sistem Fisik, yaitu suatu rangkaian unsur-unsur yang 
saling berkaitan yang beroperasi bersama untuk 
mencapai beberapa susunan atau maksud. 
[Davis, 2002 : 23] 

Masing-masing subsistem ini terdiri dari subsistem 
yang lebih penting lagi, misalnya suatu sistem yang 
berbasis komputer. Berdasarkan pembagian sistem 
kedalam bagian yang lebih kecil lagi dikenal dengan 
hierarki sistem, yaitu : pembagian sistem ditinjau dari 
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sudut peranan dan kedudukannya terhadap lingkungan, 
hierarki sistem tersebut dibagi  menjadi tiga tingkatan, 
yaitu : 
a. Supra sistem 

Supra sistem yaitu lingkungan, dimana sistem itu 
berada dalam lingkungan yang dimaksud disini juga 
berbentuk suatu sistem tersendiri yang kedudukannya 
serta peranannya terhadap lingkungan lebih luas. 

b. Sistem 
Elemen-elemen yang saling berinteraksi untuk 
mencapai tujuan tertentu. 

c. Sub sistem 
Sub sistem adalah bagian dari sistem yang secara 
mandiri membentuk sistem pula. Sistem yang mandiri 
ini kedudukannya dan peranannya lebih kecil 
daripada sistem. 
 

1.2. Karakteristik Sistem 
Sistem memiliki karakteristik tertentu, diantaranya 

adalah : 
a. Komponen-Komponen Sistem 

Suatu sistem terdiri dari sejumlah komponen-
komponen yang saling berinteraksi yang artinya saling 
bekerja sama membentuk suatu kesatuan. 

b. Batasan Sistem 
Batasan sistem (boundary) merupakan daerah yang 
membatasi antara sistem dengan sistem lainnya atau 
dengan lingkungan luarnya. 

c. Lingkungan Luar Sistem 
Lingkungan luar (environment) adalah semua hal-hal 
yang diluar batas sistem yang mempengaruhi operasi 
sistem. 

d. Penghubung Sistem 
Penghubung (interface) merupakan media penghubung 
antara satu subsistem dengan subsistem lainnya. 
Melalui penghubung ini memungkinkan sumber-
sumber daya yang mengalir dari satu subsistem ke 
subsistem lainnya. 

e. Masukan Sistem 
Masukan (input) adalah energi yang dimasukan 
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kedalam sistem. Masukan dapat berupa masukan 
peralatan (maintenence input) dan masukan sinyal 
(signal input). 

f. Keluaran Sistem 
Keluaran adalah hasil dari energi yang diolah dan 
diklasifikasikan menjadi keluaran yang berguna dan 
sisa pembuangan. 

g. Pengolah Sistem 
Pengolah sistem berfungsi untuk merubah masukan 
menjadi keluaran. 

h. Sasaran Sistem 
Sasaran atau tujuan suatu sistem sangat menentukan 
sekali masukan yang dibutuhkan sistem dan keluaran 
yang akan dihasilkan sistem. 
 

1.3. Klasifikasi Sistem 
Sistem dapat diklasifikasikan dari beberapa sudut 

pandang, diantaranya adalah: 
a Sistem diklasifikasikan sebagai Sistem Abstrak (abstract 

system) dan Sistem Fisik (physical system). Sistem 
abstrak adalah merupakan sistem yang berupa 
pemikiran-pemikiran atau ide yang tidak tampak oleh 
fisik sedangkan sistem fisik adalah sistem yang ada 
secara fisik. 

b Sistem yang diklasifikasikan sebagai Sistem Alamiah 
(natural system) dan sistem buatan manusia (human 
mode system). Sistem alamiah adalah sistem yang 
terjadi oleh alam dan tidak dibuat oleh manusia. 
Sedangkan sistem buatan manusia adalah sistem yang 
dirancang oleh manusia. 

c Sistem yang diklasifikasikan sebagai Sistem Tertentu 
(deterministic system) dan sistem tidak tentu 
(probabilistic system). Sistem tertentu beroperasi dengan 
tingkah laku yang sudah dapat diprediksi, interaksi 
antara bagian-bagian dapat dideteksi dengan pasti, 
sehingga keluaran dari sistem sudah dapat 
diramalkan. Sistem tak tentu adalah kondisi yang masa 
depannya tidak dapat diprediksi karena mengandung 
unsur probabilitas. 
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d Sistem yang diklasifikasikan sebagai Sistem Tertutup 
(closed system) dan Sistem Terbuka (open system). Sistem 
tertutup adalah sistem yang tidak berhubungan dan 
tidak berpengaruh dengan lingkungan luarnya. Sistem 
ini bekerja secara otomatis tanpa adanya campur 
tangan dari pihak luarnya. Sistem terbuka ini adalah 
sistem yang berhubungan dengan lingkungan luarnya. 
Sistem ini menerima masukan dan menghasilkan 
keluaran untuk lingkungan luar atau subsistem yang 
lainnya. 

 
2. Konsep Dasar Sistem Informasi 

Informasi merupakan hal yang sangat penting bagi 
manajemen dalam mengambil keputusan. Darimana informasi 
tersebut dapat didapatkan ? Informasi dapat diperoleh dari 
Sistem Informasi (Information System) atau disebut juga dengan 
processing system atau information processing system atau information 
generating system. 

Sistem Informasi adalah suatu sistem di dalam suatu 
organisasi yang mempertemukan kebutuhan pengolahan 
transaksi harian, mendukung operasi, bersifat manajerial dan 
kegiatan strategi dari suatu organisasi dan menyediakan pihak 
luar tertentu dengan laporan-laporan yang diperlukan. 

 

2.1. Pengertian Sistem Informasi. 
Menurut Djogiyanto Hartono, di dalam bukunya 

yang berjudul Analisis dan Desain mengemukakan bahwa 
sistem informasi adalah : 

“Suatu sistem di dalam suatu organisasi yang 
mempertemukan kebutuhan pengolahan transaksi harian, 
mendukung operasi, bersifat manajerial dan kegiatan 
strategi dari suatu organisasi yang menyediakan pihak 
luar tertentu dengan laporan-laporan yang diperlukan”. 
[Ibid : 11]. 

  

2.2. Komponen Sistem Informasi 
Komponen sistem informasi terdiri dari 

komponen-komponen yang disebut dengan istilah Blok 
Bangunan (Building Block), yang di dalamnya meliputi :  
a. Blok Masukan (Input Block) adalah input yang 

mewakili data yang masuk ke dalam sistem informasi, 
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termasuk metode-metode dan media untuk 
menangkap data yang akan dimasukkan berupa 
dokumen-dokumen dasar. 

b. Blok Model (Model Block) adalah blok yang terdiri dari 
kombinasi prosedur, logika dan matematika yang akan 
memanipulasi data input dan data yang tersimpan di 
basis data dengan cara yang sudah tertentu untuk 
menghasilkan suatu keluaran yang diinginkan. 

c. Blok Keluaran (Output Block) adalah keluaran yang 
berupa informasi yang berkualitas dan dokumentasi 
yang berguna untuk semua tingkat manajemen serta 
pemakai sistem. 

d. Blok Tekonologi (Technology Block) adalah kotak alat 
(tool box) dalam sistem informasi yang digunakan 
untuk menerima input, menjalankan model, 
menyimpan dan mengakses data, dan mengirimkan 
keluaran serta membantu mengendalikan sistem 
secara keseluruhan. 

e. Blok Basis Data (Data Base Block) adalah kumpulan dari 
data yang saling berhubungan antara satu dengan 
lainnya, tersimpan di perangkat keras komputer dan 
digunakan di perangkat lunak untuk 
memanipulasinya. 

f. Blok Kendali (Control Block) adalah pengendalian yang 
dirancang untuk mengatasi banyak hal yang merusak 
sistem informasi, diharapkan untuk meyakinkan hal-
hal yang dapat merusak sistem dapat dicegah apabila 
terlanjur terjadi kesalahan-kesalahan dapat langsung 
diatasi. 

 

3. System Development Life Cycle (SDLC) 
Siklus hidup sistem informasi merupakan penerapan 

pendekatan yang bertugas mengembangkan dan menggunakan 
sistem berbasis komputer yang terdiri dari beberapa fase-fase. 
Fase-fase ini secara bersama-sama dinamakan siklus hidup 
pengembangan sistem (System Development Life Cycle), yaitu 
penelitian sistem, analisis sistem, desain sistem, penerapan sistem, 
dan perawatan sistem. Siklus hidup sistem informasi ditunjukkan 
pada gambar 1 
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Gambar 1 Contoh Siklus Hidup Pengembangan Sistem 

 
4. Basis Data 

Basis data terdiri dari 2 kata, yaitu Basis dan Data. Basis 
dapat diartikan sebagai markas atau gudang, tempat berkumpul. 
Sedangkan Data adalah representasi fakta dunia nyata yang 
mewakili suatu objek seperti manusia, barang, hewan, peristiwa, 
konsep, keadaan dan sebagainya, yang direkam dalam bentuk 
angka, huruf, simbol, teks, gambar, bunyi, atau kombinasinya. 

Menurut Fatansyah di dalam bukunya yang berjudul Basis 
Data, mengemukakan bahwa basis data adalah : 

“Kumpulan data yang saling berhubungan yang disimpan 
secara bersama sedemikian rupa dan tanpa pengulangan yang 
tidak perlu, untuk memenuhi berbagai kebutuhan.” [Fatansyah, 
2002 : 2]. 

Prinsip kerja basis data adalah pengaturan data / arsip. 
Dan tujuan utamanya adalah kemudahan dan kecepatan dalam 
pengambilan kembali data / arsip. Yang sangat ditonjolkan dalam 
basis data adalah pengaturan / pemilahan / pengelompokan / 
pengorganisasian data yang akan kita simpan sesuai fungsi / 
jenisnya. Pemilahan / pengelompokkan / pengorganisasian ini 
dapat berbentuk sejumlah file / tabel terpisah atau dalam bentuk 
pendefinisian kolom-kolom / field-field data dalam setiap file / 
table. 

Perawatan Sistem

Investigasi

Analisis

Penerapan Sistem

Desain Sistem



 

 

82       | Vol. 5 No. 1 | Feb. 2017 

 

 Techno Preneurship Jurnal Ilmiah Politeknik Piksi Input Serang 

 

Sebuah sistem basis data dapat memiliki beberapa basis 
data. Setiap basis data dapat berisi atau memiliki sejumlah objek 
basis data (seperti file atau table, indeks, dan lain-lain). 
Disamping berisi atau penyimpanan data, setiap basis data juga 
mengandung atau menyimpan definisi struktur (baik untuk basis 
data maupun objek-objeknya secara detail).  

 
5. Teori Tentang Permasalahan 

Adapun teori-teori tentang permasalahan adalah sebagai berikut : 
5.1. Definisi Inventory (Persediaan) 

Inventory (persediaan) merupakan salah satu 
perkiraan kelompok harta lancar dalam neraca yang 
memiliki peranan penting dalam kegiatan perusahaan. 
Untuk memahami apa yang dimaksud dengan persediaan, 
berikut ini akan dikemukakan definisi persediaan. 

Menurut Sofjan Assauri, dalam bukunya yang 
berjudul Manajemen Produksi dan Operasi, mengemukakan 
bahwa : 

“Persediaan adalah suatu aktiva yang meliputi 
barang-barang milik perusahaan dengan maksud untuk 
dijual dalam suatu periode usaha yang normal, atau 
persediaan barang-barang yang masih dalam pengerjaan 
atau proses produksi, ataupun persediaan bahan baku 
yang menunggu penggunanya dalam suatu proses 
produksi.” [Sofjan, 2000 : 169]. 

Dalam perusahaan untuk menentukan berapa 
banyak suatu persediaan yang diperlukan, maka akan 
menggunakan sistem basis data untuk mempercepat suatu 
informasi tersebut. Semakin lengkap, akurat dan dapat 
menampilkan kembali data-data yang termuat dalam 
sistem bais data tesebut. 

Ditinjau dari jenis perusahaan masalah persediaan 
dapat dibagi menjadi dua bagian, yaitu persediaan 
perusahaan perdagangan dan persediaan perusahaan 
industri atau manufaktur. Adapun jenis-jenis persediaan 
tersebut adalah sebagai berikut : 
a. Persedian Perusahaan Dagang 

Dalam perusahaan perdagangan, persediaan 
dikenal dengan instilah merchandise inventory. 
Persediaan disini dibeli oleh perusahaan dengan 
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tujuan untuk dijual kembali tanpa mengalami 
perubahan bentuk atau pengolahan lebih lanjut 

b. Persediaan Perusahaan Manufaktur 
Persediaan dalam perusahaan industri atau 
manufaktur umumnya mempunyai tiga jenis, yaitu 
persediaan bahan baku, persediaan barang dalam 
proses, dan persediaan barang jadi. 
 

5.2. Definisi Bahan Baku 
Menurut Pusat Bahasa, bahan baku adalah 

persediaan yang digunakan dalam proses produksi bahan 
baku yang dapat diperoleh dari sumber-sumber alam atau 
dibeli dari supplier atau dibuat sendiri oleh perusahaan 
yang menghasilkannya. 
Definisi Gudang 

Menurut Pusat Bahasa, gudang (warehouse) adalah 
tempat penyimpanan bahan baku / barang di dalam suatu 
perusahaan. 
  

5.3. Menjalankan Visual Basic 6.0  dan Membuat Aplikasi 
Baru 

Visual Basic juga merupakan sebuah program 
aplikasi Windows, oleh sebab itu harus menjalankannya 
dari dalam Windows.  Seperti biasa, melakukan ini dari 
menu Start. 

 
a. Klik tombol Mouse pada menu Start                 . 
b. Pilih menu Programs > Microsoft Visual Basic 6.0 > Microsoft 

Visual Basic 6.0 
c. Sebuah Kotak Dialog seperti pada Gambar 2.9 akan muncul 

saat akan memulai Visual Basic. Di sini bisa memilih jenis 
aplikasi yang akan dibuat dengan Visual Basic.  Biasanya 
untuk membuat aplikasi standar, pilihlah Standard EXE, lalu 
klik tombol Open. 
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Gambar 2 Kotak Dialog New Project 
d. Setelah Visual Basic dijalankan, akan muncul sebuah layar 

seperti pada gambar 2.10. Layar ini adalah lingkungan 
pengembangan aplikasi Visual Basic yang akan digunakan 
untuk membuat program-program aplikasi dengan Visual 
Basic. 

 
 

 
 
 
 
 

 
 
 

 
 

Gambar 3. Lingkungan Pengembangan Visual Basic 6.0 
 

5.4. Toolbar 
Toolbar adalah tombol-tombol yang mewakili suatu 

perintah tertentu dari Visual Basic.  Setiap tombol tersebut 
dapat langsung diklik untuk melakukan perintah tertentu. 
Biasanya tombol-tombol ini merupakan perintah-perintah 
yang sering digunakan dan terdapat pula pada menu 
Visual Basic. Toolbar yang umum adalah Toolbar standar, 
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ditunjukkan  pada gambar 4. 
 
 
 
 

 
 

 
 
 
 
 

Gambar 4 Toolbar Standard Visual Basic 
 

Untuk menampilkan macam-macam Toolbar yang 
ada, pilih menu View > Toolbars. Kegunaan masing-masing 
tombol pada Toolbar Standard Visual Basic  dapat dilihat 
pada tabel 1. 

 
Tabel 1.  Kegunaan Toolbar Standard Visual Basic 

Nama Fungsi 

Add Project Menambahkan proyek ke dalam proyek 
yang sudah ada. 

Add Item Menambahkan komponen atau obyek ke 
dalam jendela Form. 

Menu Editor Menampilkan Menu Editor untuk 
mengubah tampilan menu. 

Open Project Membuka proyek Visual Basic  yang sudah 
ada. 

Save Project Group Menyimpan proyek Visual Basic pada 
komputer. 

Cut Memotong elemen yang dipilih pada layer 
Copy Meng-copy elemen yang dipilih pada layer. 
Paste Menyalin elemen yang sebelumnya sudah 

dipotong (Cut) atau disalin (Copy). 
Find Mencari teks tertentu. 
Undo Membatalkan perintah atau tindakan 

terakhir. 
Redo Mengulangi perintah atau tindakan 

terakhir yang dibatalkan. 

Add Project 

Add Item 

Menu 
Editor 

Open 
Project 

Save 
Projec
t 

Cut 

Copy 

Paste 

Fin
d 

Undo 

Redo 

Start 

Break 

End 

Project 
Explorer 

Prperties 
Window 

Form 
Layout 

window 

Object 
Browser 

  Toolbox 

Data view 
window 

Visual 
component 

manager 
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Start Menjalankan proyek yang dibuat pada 
Visual Basic. 

Break Menghentikan running program untuk 
sementara. 

End Menghentikan running program. 
Project Explorer Menampilkan jendela Project Explorer. 
Properties Window Menampilkan jendela Properties. 
Form Layout Window Menampilkan Jendela Layout Window. 
Object Browser Menampilkan Jendela Object Browser. 
Toolbox Menampilkan Jendela Toolbox. 
Data View Window Menampilkan Jendela Data View Window. 
Visual Component 
Manager 

Menampilkan Jendela Visual Component 
Manager. 

 
5.5. Toolbox 

Toolbox  adalah sebuah “kotak peranti”  yang 
mengandung semua kontrol yang dibutuhkan untuk 
membentuk suatu program aplikasi. Kontrol adalah suatu 
obyek yang akan menjadi Interface antara program aplikasi 
dan pemakainya, dan semuanya harus diletakkan di 
dalam jendela Form. 

Untuk bisa menambahkan obyek pada Toolbox ini 
adalah dengan memilih menu Project > Component. Toolbox  
dapat dilihat pada gambar 5. 

 
 
 

 
 
 
 
 
 

Gambar 5. Toolbox Standard Visual Basic 
 

C. METODE  PENELITIAN 
1. Metode Penelitian  

Metode penelitian yang digunakan dalam penelitian ini 
adalah metode penelitian yang bersifat deskriptif, yaitu suatu 
metode yang digunakan untuk meneliti status sekelompok 
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manusia, suatu objek, suatu set kondisi, suatu sistem pemikiran, 
ataupun suatu kelas peristiwa pada masa sekarang. Penulis juga 
menggunakan metode Analysis and Design dimana transformasi 
informasi input dan output dinyatakan dengan menggunakan 
aliran data diagram atau Data Flow Diagram (DFD) di dalam 
perancangan system informasi Inventory gudang pada PT. Lung 
Cheong Brothers Industrial. 

 
2. Metode Pengumpulan Data  

 Metode pengumpulan data dalam penelitian ini yang  
berupa wawancara, observasi, dan literature. Metode-metode 
tersebut diatas adalah sebagai berikut :  
2.1. Metode Wawancara  

 Wawancara (interview) adalah suatu bentuk 
komunikasi verbal, yaitu semacam percakapan yang 
bertujuan untuk memperoleh informasi. 
 Wawancara telah diakui sebagai teknik 
pengumpulan data / fakta yang penting dan banyak 
dilakukan dalam pengembangan sistem informasi. Dalam 
wawancara ini analisis sistem sebagai pewawancara untuk 
mengumpulkan data secara tatap muka langsung dengan 
orang yang diwawancarai.  
 Wawancara pada umumnya dapat dibedakan 
menjadi dua macam, yaitu :  
a. Wawancara Terstruktur  

Dalam wawancara ini semua pertanyaan telah 
dirumuskan sebelumnya dengan cermat, biasanya 
secara tertulis.  

b. Wawancara Tidak Terstruktur (Bebas)  
Dalam wawancara serupa ini tidak dipersiapkan 
daftar pertanyaan sebelumnya. Pewawancara hanya 
menghadapi suatu masalah secara umum. Pertanyaan 
yang timbul secara spontanitas dari pewawancara.  

 Setelah melakukan penelitian dan menganalisa 
masalah-masalah yang dihadapi hasil dari metode 
wawancara tersebut adalah sebagai berikut :   
a. Proses pendataan Inventory bahan baku gudang yang 

telah masuk.  
b. Kendala - kendala yang dihadapi dalam pendataan 

persediaan bahan baku. 
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c. Batasan - batasan dalam pendataan persediaan bahan 
baku.  

 
2.2. Metode Observasi  
  Metode observasi atau pengamatan merupakan 

salah satu metode pengumpulan data / fakta yang cukup 
efektif. Observasi merupakan pengamatan langsung suatu 
kegiatan yang bertujuan untuk menguji validitas dari data 
hasil wawancara yang telah didapatkan. Metode observasi 
yang telah dijalankan dalam penelitian ini adalah metode 
yang langsung ke bagian pengolahan data Inventory 
gudang sehingga semuanya itu dapat dilihat secara 
langsung tentang pengolahan data Inventory gudang yang 
selama ini telah berjalan.  

  Hasil dari metode observasi adalah :  
a. Proses penyusunan hasil pengolahan data Inventory 

bahan baku gudang yang telah ada kurang efektif.  
b. Masih adanya data bahan baku yang salah dalam 

pengecekan dan salah perhitungan dengan data - data 
yang sebenarnya dimana data tersebut harus tepat dan 
akurat.  

c. Data - data yang berhubungan dengan Inventory 
bahan baku gudang disimpan dalam bentuk manual.  

 
D. ANALISIS DAN PEMBAHASAN 
1. Perancangan Sistem 

 Tujuan dari perancangan sistem adalah untuk memenuhi 
kebutuhan dari pemakai sistem (user) mengenai gambaran yang 
jelas tentang rancangan sistem yang akan dibuat serta 
diimplementasikan ke dalam perangkat lunak. Perancangan 
sistem ini didukung dengan perangkat lunak (software) dan 
perangkat keras (hardware) yang berfungsi sebagai sarana 
pengolah data dan sekaligus penyedia informasi yang 
dibutuhkan. 
1.1. Metode Perancangan 

Metode perancangan yang digunakan untuk 
mengembangkan sistem informasi persediaan bahan baku 
gudang adalah metode perancangan terstruktur 
(Struktured Analysis and Design) menggunakan Data Flow 
Diagram (DFD). Data Flow Diagram (DFD) merupakan 
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konsep perancangan dengan penekanan pada sistem 
modular, top down design, dan pemrograman terstruktur. 
Metode perancangan  yang  digunakan antara lain 
meliputi : 
a. Diagram Konteks, yaitu diagram yang 

menggambarkan sistem yang ada di dalamnya secara 
keseluruhan. 

b. Data Flow Diagram (DFD), yaitu hasil dari pembagian 
diagram menjadi beberapa level yang lebih kecil untuk 
menggambarkan kejadian yang berlangsung dalam 
suatu sistem. 

c. Relasi Tabel, yaitu model data relasional dengan cara 
menghubungkan antar file direlasikan dengan kunci 
relasi yang merupakan kunci utama masing-masing 
file.  

 
1.2. Normalisasi  

Tujuan desain ini adalah mengkonstruksi relasi tanpa 
adanya redudansi. Untuk melakukan desain ini 
diperlukan pendefinisian kondisi yang memenuhi relasi 
tanpa redudansi. Kondisi ini didefinisikan dalam 
terminology relasi normal. Relasi seharusnya berada 
dalam bentuk normal tertinggi dan bergerak dari bentuk 
normal satu dan seterusnya untuk setiap kali membatasi 
hanya satu jenis redudansi. 
Ide dasar normalisasi berkaitan erat dengan kunci relasi 
dan dependensi antar kunci. Secara sederhana, relasi 
seharusnya hanya menyimpan fakta tentang kunci relasi. 
Karena itu penting untuk mengerti kunci relasi dan cara 
dependensi merepresentasikan fakta. 
Proses normalisasi merupakan proses pengelompokkan 
data elemen menjadi tabel-tabel yang menunjukkan entity 
dan hubungannya. Pada proses normalisasi harus selalu 
diuji beberapa kondisi, yaitu apakah ada kesulitan pada 
saat menambahkan data (insert data), menghapus data 
(delete data), mengubah data (update data), mengubah data 
(update data) dan membaca data (retrive data). Bila masih 
ada kesulitan, maka tabel-tabel tersebut dapat dipecah-
pecah lagi atau dengan kata lain, perancangan belumlah 
menghasilkan suatu database yang optimal.  
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13 Perancangan Sistem Basis Data 

Penggambaran Sistem Informasi Inventory Bahan Baku 
Gudang, diperlukan file basis data, yaitu seperti yang 
ditunjukan pada tabel  2.  
 
Tabel 2. File Basis Data Sistem Inventory Bahan Baku 

Gudang 
 

No Nama File  Basis Data Keterangan 

1 Stock.DB 
File basis data yang berisikan tentang 
data bahan baku yang ada digudang 
(lihat tabel 2) 

2 Suplier.DB 
File basis data yang berisikan tentang 
data supplier yang masuk (lihat tabel 
3) 

3 
Data Order Bahan 
Baku Supplier.DB 

File basis data yang berisikan data 
order bahan baku supplier (lihat tabel 
4)  

4 
Data Order Bahan 
Baku Departemen.DB 

File basis data yang berisikan data 
order  bahan baku departemen (lihat 
tabel 5) 

5 
Data Bahan Baku 
Supplier.DB 

File basis data yang berisikan data 
tentang data bahan baku supplier 
(lihat table 6) 

6 
Data Bahan Baku 
Departmen.DB 

File basis data yang berisikan data 
bahan baku departemen (lihat tabel 7) 

 
Dari file basis data diatas (pada tabel 1) 

mempunyai field serta fungsi masing-masing. Adapun field 
serta fungsi tersebut adalah sebagai berikut : 
a. Stock.DB 

Stock.DB adalah suatu tabel data yang 
berisikan data bahan baku yang ada pada gudang, 
seperti ditunjukkan pada table 2 
Nama Tabel : Stock.DB 
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Field Kunci : Item 
Fungsi   : Untuk memasukkan data bahan 
baku, bahan                  baku yang ada pada gudang 
 
Tabel 2. Stock.DB 

Nama Field 
Jenis 
Data 

Panjang Keterangan 

Item* Text 6 Item Sebagai Kunci Utama 

Description Text 30 Description (Keterangan) 

Part No Text 50 Part No (No Bagian) 

Part Name Text 15 Part Name (Nama Bagian) 

Usage Text 5 Usage(penggunaan) 

Unit Text 5 Unit (Satuan) 

First Stock Text 10 First Stock (Stock Awal) 

In Text 10 In (Barang Masuk) 

Cum Text 10 Cum(Jumlah Stock) 

Out Text 10 Out(Barang Keluar) 

Cum Text 10 
Cum (Jumlah Setelah 
Barang Keluar) 

Stock Text 10 Stock(Persediaan Akhir) 

 
b. Supplier.DB 

Supplier.DB adalah suatu tabel data yang berisikan 
data supplier yang masuk ke gudang, seperti 
ditunjukkan pada tabel 3. 
Nama Tabel : Supplier.DB 
Field Kunci : SupplierID 
Fungsi  : Untuk memasukkan data supplier  
     yang  masuk ke gudang 

                                  Tabel 3 Supplier.DB  

Nama Field 
Jenis 
Data 

Panjang Keterangan 

SupplierID* Text 10 SupplierID * 

CompanyName Text 20 CompanyName 

ContactName Text 20 ContactName 

Address Text 50 Address 

City Text 10 City 

Region Text 10 Region 

PostalCode Text 10 PostalCode 
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Country Text 10 Country 

Phone Text 10 Phone 

Fax Text 10 Fax 

HomePage Hyperlink 20 HomePage 

 
c. Data Order Bahan Baku Supplier.DB 

Transaksi Data Order Bahan_Baku Suppplier.DB 
adalah suatu tabel data yang berisikan tentang data 
order bahan baku supplier, seperti ditunjukan pada 
tabel 4. 
Nama Tabel : Data Order Bahan Baku  
                            Supplier.DB  
Field Kunci : No Item  
Fungsi  : Untuk memasukan data kebutuhan  
                             bahan baku yang diterima dari  
                             supplier 
Tabel 4 Order Bahan Baku Supplier.DB 

Nama Field 
Jenis 
Data 

Panjang Keterangan 

Item Text 10 Item* 

SupplierID Text 10 SupplierID* 

CodeLCbi Text 20 CodeLCbi 

NamaBarang Text 20 NamaBarang 

Unit Text 50 Unit 

Qty Text 10 Qty 

Harga Text 10 Harga 

Jumlah Text 10 Jumlah 

JadwalKirim Text 10 JadwalKirim 

Keterangan Text 10 Keterangan 

Total Text 15 Total 

 
d. Data Order Bahan Baku Departemen.DB 

Order Bahan Baku Departemen.DB adalah suatu 
table data yang berisikan tentang order bahan baku 
departemen yang dikeluarkan dari departemen, 
seperti ditunjukkan pada table 5. 
Nama Tabel : Order Bahan Baku Departemen.DB 
Field Kunci : No Order 
Fungsi  : Untuk memasukkan data yang 
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berisikan 
  tentang permintan barang kepada 
  supplier. 
 

Tabel 5 Order Bahan Baku Departemen.DB  

Nama Field Jenis Data Panjang Keterangan 

NoOrder Text 10 NoOrder 

SupplierID Text 10 SupplierID 

Produk Text 20 Produk 

NoBpb Text 20 NoBpb 

Kepada Text 20 Kepada 

Alamat Text 50 Alamat 

Telepon Date/Time 10 Telepon 

Fax Text 10 Fax 

Tanggal Text 10 Tanggal 

BuyerPoNo Text 10 BuyerPoNo 

Item Text 15 Item 

CodeLcbi Text 20 CodeLcbi 

NamaBarang Text 10 NamaBarang 

Unit Text 5 Unit 

Qty Text 10 Qty 

Harga Text 10 Harga 

Jumlah Text 10 Jumlah 

JadwalKirim Text 10 JadwalKirim 

Keterangan Text 10 Keterangan 

 
e. Data Bahan Baku Supplier.DB 

Data Bahan Baku Supplier.DB adalah suatu table 
data yang berisikan data bahan baku , seperti 
ditunjukkan pada table 6. 
Nama Tabel : Data Bahan Baku Supplier.DB 
Field Kunci : No 
Fungsi  : Untuk memasukkan data-data 
                           bahan baku supplier.    
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Tabel 6 Data Bahan Baku Supplier.DB 

Nama Field 
Jenis 
Data 

Panjang Keterangan 

No Text 10 No * 

SupplierID Text 20 SupplierID* 

DeliveryQty Text 20 DeliveryQty 

MeterialNo Text 20 MeterialNo 

Description Text 50 Description 

 
f. Data Bahan Baku Departemen.DB 

Data Bahan Baku Departemen.DB adalah suatu 
table data yang berisikan data bahan baku 
departmen , seperti ditunjukkan pada table 7. 
Nama Tabel : Data Bahan Baku Departemen.DB 
Field Kunci : Customer 
Fungsi  : Untuk memasukkan data-data 
                          bahan baku departemen.    
Tabel 7 Data Bahan Baku Departemen.DB 

Nama Field 
Jenis 
Data 

Panjang Keterangan 

Customer Text 10 Customer* 

ModelNo Text 20 ModelNo 

ModelName Text 20 ModelName 

To Text 50 To 

IssuedDate Date/Time 10 IssuedDate 

PoNo Text 10 PoNo 

PoQty Text 10 PoQty 

BPB Text 10 BPB 

TypeMaterial Text 10 TypeMaterial 

PartNo Text 15 PartNo 

PartName Text 20 PartName 

Usage Text 10 Usage 

Unit Text 5 Unit 

LimitQty Text 10 LimitQty 

Extra Text 10 Extra 

CumQtyIssued Text 10 CumQtyIssued 

ToBeIssued Text 10 ToBeIssued 

TakingByProd Text 10 TakingByProd 

BalanceQty Text 10 BalanceQty 
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2. Implementasi Sistem  
a. Implementasi Form Menu Login 

Form menu login  terdiri dari 1 form, 2 label, 2 text box, dan 
2 command button. Fungsi form menu login adalah untuk 
memasukan data yang sesuai dengan nama pengguna 
(user) dengan kata kunci yang sudah tersimpan pada 
source menu login. Tampilan dari form menu login dapat 
dilihat pada gambar 6 dibawah ini. 

 
 
 
 
 
 
 
 

Gambar 6  Implementasi Form Menu Login 
 

Cara Pembuatan Antar Muka Form Menu Login 
yaitu sebagai berikut : 
1. Klik file > project kemudian tampil kotak dialog Add  

form kemudian pilih Log In Dialog > open. Setelah itu 
akan muncul kotak dialog project1 form login. 

2. Untuk mengaktifkannya klik dua kali pada command 
button ok maka akan keluar jendela code. 

3. Untuk tombol cancel, klik dua kali pada command 
button cancel dan kemudian isikan source-nya. 

 

b. Implementasi Form Menu Utama 
 Form menu utama terdiri dari 1 form, 4 menu bar, 
dan 6 menu list.fungsi dari form menu utama adalah suatu 
tampilam form secara keseluruhan untuk dapat melakukan 
pengolahan data dan pengolahan laporan yang telah 
dibuat dengan menu editor. Implementasi form menu 
utama inventory bahan baku gudang pada PT. Lung 
Cheong Brothers Industrial dapat dilihat pada gambar 2.  
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Gambar 7 Implementasi Form Menu Utama Inventory Bahan Baku Gudang 

 
Cara Membuat Antar Muka Form Menu Utama yaitu sebagai 

berikut : 
Klik project pada menu bar visual basic kemudian pilih mdi form 
Klik Tools > Menu Editor dan akan tampil jendela Menu Editor. 
Pada jendela menu editor yang tampil, ketikan “&Master” pada kotak 

Caption,  
Pada kotak Name ketikan “MnMaster” untuk menjadikan nama 

internal atau identitas dari objek menu File tersebut. 
Ulangi langkah-langkah seperti diatas untuk membuat menu lainnya. 
      Tabel 8 Menu Utama Master 

Menu Properties Setting 

Master 
Name &Master 

Caption mnumaster 

Transaksi 
Name &Transaksi 

Caption mnutransaksi 

Laporan 
Name &Laporan 

Caption mnulaporan 

About 
Name &About 

Caption mnuabout 

 
6. Langkah-langkah dalam pembuatan sub menu File adalah sebagai 

berikut : 
(a) Klik command Next pada tampilan menu editor pada &Master. 
(b) Pada kolom Caption ketikkan &Master Bahan Baku dan 

mnmasterbahanbaku pada kolom Name. 
(c) Klik tanda panah     untuk menyatakan &Master Bahan Baku  

sebagai sub menu dari &Master.  
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(d)Lakukan langkah-langkah yang sama seperti di atas untuk 
membuat submenu – submenu lain di bawah menu 
berikutnya. 

 

Tabel 9. Sub Menu  

Menu Properties Setting 

Bahan Baku 
(Pada Master) 

Name &Bahan Baku 

Caption mnubahanbaku 

Supplier (Pada 
Master) 

Name &Supplier 

Caption mnusupplier 

Order Bahan 
Baku 
Departemen(Pad
a Transaksi) 

Name 
&Order Bahan Baku 
Departemen 

Caption 
mnuorderbahanbakudeparte
men 

Data Bahan Baku 
Departemen(Pad
a Transaksi) 

Name 
&Data Bahan Baku 
Departemen 

Caption 
mnudatabahanbakudepartem
en 

Data Order 
Bahan Baku 
Supplier(Pada 
Transaksi) 

Name 
&Data Order Bahan Baku 
Supplier 

Caption 
mnudataorderbahanbakusup
plier 

Data Bahan Baku 
Supplier(Pada 
Transaksi) 

Name &Data Bahan Baku Supplier 

Caption mnudatabahanbakusupplier 

Master Laporan 
(Laporan) 

Name &Master Laporan 

Caption mnumasterlaporan 

 
(e) Hasil akhir dari pembuatan form menu utama ini ditunjukkan 

oleh gambar 8. 
 
 
 
 
 
 
 

 
      Gambar 8 Implementasi Form Menu Editor 
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3. Analisis Terhadap Antar Muka (Interface) Sistem 
Antar muka menjadi hal yang sangat penting dalam suatu 

perangkat lunak, perangkat lunak yang mempunyai antar muka 
(interface) yang baik harus bersifat ramah pengguna (user friendly), 
artinya mudah digunakan, mudah untuk dipelajari, tidak 
membingungkan pengguna serta tidak banyak menghabiskan 
waktu untuk menyelesaikan pekerjaannya dengan menggunakan 
sistem tersebut.  
Analisis Form Login 
Form ini digunakan untuk awal masuk ke sistem, karena pada 
sistem ini masing-masing user diberikan hak akses, ini berfungsi 
untuk keamanan sistem. Pada awalnya seorang user yang ingin 
memulai masuk ke sistem ini harus memasukkan Name User dan 
password... 
Jika User Name atau passwordnya cocok maka user tersebut dapat 
mengakses sistem, sedangkan bila salah satu atau keduanya tidak 
cocok maka user tersebut tidak dapat masuk ke sistem ini. 
Tampilan keterangan kesalahan pada saat pemasukkan User Name 
dan password dapat dilihat pada gambar 9. 
 
 

 
 

 
 

Gambar 9.  Keterangan Kesalahan Pada Saat  Pemasukan 
User Name Atau  Password 

 
 Analisis Form Bagian Pemasukan Data  

Pada saat User melakukan pemasukan data, tampil pesan seperti 
pada gambar 10.  
 
 
 
 

 
 

Gambar 10. Pesan  Pada Saat User Menekan Tombol New  
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Analisis Form Bagian Penghapusan Data 
Pada saat User menggunakan Command Button Hapus untuk 
menghapus data maka akan tampil pesan seperti pada gambar 11. 

 
 
 
 

 
Gambar 11. Pesan  pada saat  Command Button Hapus di klik 

 
Analisis Form Bagian Pencarian Data 
Dan pada saat User melakukan pencarian data tetapi data tidak 
ditemukan maka akan tampil pesan seperti pada gambar 12 
 

.  
 
 
 
 
 

Gambar 12. Pesan  Pada Saat Data Yang Dicari Tidak Ada 
 
 
E. KESIMPULAN DAN SARAN 
1 Kesimpulan 

 Setelah menyelesaikan pembuatan aplikasi dan 
menganalisa permasalahan yang terjadi selama proses 
perancangan Sistem Informasi Inventory Bahan Baku Gudang 
pada PT. Lung Cheong Brothers Industrial, maka penulis dapat 
mengambil kesimpulan sebagai berikut: 
a. Sistem pengolahan data inventory bahan baku gudang yang 

ada belum memberikan hasil yang maksimal sehingga 
diperlukan adanya perbaikan pada sistem sebelumnya 
dengan merancang sistem informasi inventory bahan baku 
gudang secara terkomputerisasi. 

b. Dengan adanya perbaikan sistem inventory bahan baku 
gudang ini, maka dapat meningkatkan kinerja proses 
pengolahan, pendataan maupun pembuatan laporan yang 
berhubungan dengan sistem inventory bahan baku gudang, 



 

 

100       | Vol. 5 No. 1 | Feb. 2017 

 

 Techno Preneurship Jurnal Ilmiah Politeknik Piksi Input Serang 

 

sebab beberapa pekerjaan yang sebelumnya dilakukan secara 
manual menjadi lebih mudah, cepat dan akurat. 

c. Dengan diterapkannya komputer sebagai alat bantu dalam 
Sistem Informasi Perekrutan Karyawan akan terjadi 
peningkatan efisiensi pengolahan data, karena dengan 
pemanfaatan komputer, pekerjaan menjadi lebih mudah dan 
cepat terselesaikan. 

d. Implementasi sistem dibuat dalam bentuk antar muka 
menggunakan Microsoft Visual Basic 6.0 akan memberikan 
informasi kegiatan kerja di bagian Gudang pada  PT. Lung 
Cheong Brothers Industrial. 

e. Keunggulan sistem baru dibandingkan dengan sistem yang 
lama adalah sebagai berikut : 
1. Perubahan sistem yang masih manual ke dalam aplikasi 

sistem informasi inventory bahan baku gudang akan 
memberikan informasi yang lebih cepat dan akan 
membuat sistem pengolahan data lebih mudah dan cepat. 

2. Dapat mencegah adanya inkonsistensi, dengan 
mengintegrasikan antara file-file yang berhubungan 
sehingga perubahan data pada suatu file akan mengubah 
secara otomatis file yang lain. 

f. Kelemahan sistem tunjangan kesehatan karyawan ini adalah 
ruang penyimpanan yang terbatas dan masih menggunakan 
sistem single user. 

 
2 Saran 

 Dalam hal ini penulis menyadari bahwa sistem ini masih 
banyak kekurangan dan kelemahan, oleh karena itu disarankan : 
a. Untuk pengembangan selanjutnya, diharapkan dapat 

menggunakan aplikasi yang memiliki ruang penyimpanan 
besar dan menggunakan sistem multi user atau menggunakan 
jaringan.. 

b. Untuk pengembangan selanjutnya, pengembangan 
diharapkan dapat membuat fasilitas online yang langsung 
menangani pendataan inventory bahan baku gudang. 

c. Perlu adanya fasilitas back_up data yang memungkinkan data-
data penting tersimpan dengan aman. 

d. Untuk pengguna sistem, diharapkan pengguna yang memakai 
fasilitas aplikasi sistem informasi inventory bahan baku 
gudang benar-benar mengetahui fungsi-fungsi yang ada, 
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memahami input, proses, serta alur sistem agar dapat 
menghasilkan informasi yang cepat, tepat, dan akurat. 
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